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The New Outlook 365 - Built for today, designed for the future 
Maximize your experience with the new Outlook for Windows, which offers the newest features, intelligent 
assistance from Microsoft Copilot, and a sleek, streamlined design. This updated version helps you stay 
connected, organized, and productive with its advanced capabilities and contemporary interface.  

Outlook Premium is a premium version of Outlook.com that is included in a Microsoft 365 subscription. It 
includes advanced protection against phishing and malware, no ads, and other premium features for your 
Outlook.com account. If you have an Office 365 subscription, then you already have a premium 
Outlook.com account which is an ad-free Outlook.com account having a higher mailbox capacity.  

Note: Limitation - The new Outlook provides only limited support for public folders. You should continue 
using the classic Outlook for window if you depend heavily on public-folder features such as creating, 
modifying, or deleting public folders in Outlook.  

Choose what you’re currently using for your email and calendar to learn how to start using new Outlook  

Tip: You can switch back whenever you want, just switch the toggle off in the new Outlook and it will 
automatically open the classic version.  

Important: New Outlook for Windows supports Exchange-backed Microsoft 365 work or school accounts, 
Outlook.com accounts, and Gmail. Currently, the new Outlook for Windows does not support other 
account types like Yahoo!, iCloud, or other account types connecting through POP/IMAP protocols. New 
Outlook for Windows also does not currently support On-Premises, Hybrid, or Sovereign Exchange 
deployments. 

Classic Outlook on Windows 
If your accounts are supported in the new Outlook for Windows, you'll see a toggle in the upper right of 
classic Outlook to Try the new Outlook. Selecting this toggle will download the new app and let you switch 
to the preview. 

New and classic Outlook for Windows feature comparison - Microsoft Support 

 

The new Outlook for Windows will launch into the account you have set as your default send account in 
Outlook. If Outlook can't sign you in automatically, manually type in the account and sign in. 

  

https://support.microsoft.com/en-us/office/new-and-classic-outlook-for-windows-feature-comparison-de453583-1e76-48bf-975a-2e9cd2ee16dd
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New User Interface 
With the new Outlook there are a few changes to the user interface. At the top right you will find a mini 
toolbar with commands like Copilot, Settings and To Do’s. 

 

Ribbon 
You can make the ribbon larger (the classic experience) or smaller (the simplified experience) using the 
dropdown arrow on the right side of the bar. If you want to personalize the commands you see in the 
simplified ribbon, select Customize. 

 

Navigation Bar and My Day 

On the left side you’ll see the navigation bar, which makes it simple to 
switch to Calendar, Contacts, or any other app you frequently use. For 
quick access to your calendar or tasks without leaving the inbox, you can 
use My Day by selecting the icon in the upper right. 

Emails 
When creating a new email, the new Outlook for Windows offers a more 
streamlined and modern experience compared to the classic version. Here are some key differences: 

1. Simplified Ribbon: The new Outlook features a minimalist ribbon with fewer icons and words, making 
it less cluttered and easier to navigate. You can still switch to the classic ribbon if you prefer more 
options. 

2. AI Assistance: The new Outlook includes AI-powered suggestions for spelling, grammar, and tone, 
helping you write more effective emails. 

3. Integrated Features: You can easily access OneDrive files, schedule email sends, and undo sent 
emails directly from the new email window. 

4. Personalization: The new Outlook allows for more personalized layout options, such as adjusting the 
density of the interface to be Roomy, Cozy, or Compact. 

5. Settings Accessibility: Settings are more conveniently located in the new Outlook, making it easier to 
adjust your preferences without digging through menus. 

Overall, the new Outlook aims to provide a more efficient and user-friendly experience, especially for those 
using Microsoft 365 business accounts. 
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Create and add an email signature in Outlook on the web 

Create a signature for your email messages that you can add automatically to all outgoing messages or 
manually to specific ones. 

Favorites 
Favorites give visibility to folders that are otherwise buried in your mail folder list. 

Favorites, a subset of your mail folders, appear at the top of the navigation pane. Using Favorites isn’t a 
requirement for this system to work, but if you have a small screen, you can minimize the Navigation Pane 
and still successfully file your messages by dragging messages to the minimized bar, perform common 
searches, and navigate to the Calendar, Contacts, and Tasks. 

It’s considered best practice to have the following folders in your Favorites: Inbox, 1-Reference, Sent 
Items, and Deleted Items. 

Pin Emails 
Do you ever have trouble tracking down that key email thread you’re actively responding to? Or is there an 
email with key information you frequently 
refer to? Now, simply right-click any 
message and choose Pin and that email 
will appear at the top of your inbox, saving 
you time from having to go back and 
search for it. 

Snooze Email 
Sometimes email is very important, but not yet. With the Snooze feature, you can schedule a time for the 
email to be re-delivered to your inbox, appearing at the 
time you want it to, so you can handle it when it’s the 
right time for you.  

1. Right-click any message. 
2. Click Snooze or select Snooze from the 

ribbon.  
3. Then choose the time you want it to be 

delivered. 

Schedule When to Send Email 
In the New Outlook for Windows, you can delay the delivery of individual messages.  

To delay delivery of an email in Outlook 365, you can follow these steps: 

1. While composing a message, select the dropdown next to Send and choose Schedule send. Select a 
default option or set a custom time. 

2. The message will remain in the Draft folder until the delivery time. 
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3. Alternatively, go to Options > three dots > Delay Delivery. Select "Do not deliver before" and set a date 
and time. 

If you send an email outside of normal working hours, you will receive a message at the top about 
Schedule Send. 

Schedule a Meeting from an Email with Copilot 
Copilot makes it fast and easy to schedule a meeting from an email thread. 

When you use the Schedule with Copilot option, Copilot analyzes the email and creates a meeting 
invitation for you, filling in a meeting title and agenda, and adding the email thread as an attachment. The 
people on the email thread are included as meeting attendees, and you can quickly review the invitation, 
add or change info, and then send it out. 

Note: This feature is only available if you have a Microsoft 365 Copilot (Work) license. 

1. Open an email conversation in Outlook. 
2. In the toolbar, select Schedule with Copilot. 

Note: The toolbar may look slightly different, depending on your settings. 

3. Select Insert to accept the content Copilot has suggested (you can edit it in the next step, if needed). 
4. Review the meeting invitation, make any changes you want to make, and when you're ready, 

select Send. 

Sweep 
Clean up your inbox and keep your email organized with automatic filtering and sorting, and by 
using tools on the command bar like Sweep, Archive, and Move to. 

Use Sweep to quickly delete unwanted email in your Inbox. Sweep gives you options to automatically delete 
all incoming email from a particular sender, to keep only the latest email, or to delete email older than 10 
days. 

1. Select an email message from the 
sender whose messages you want to 
delete. 

2. On the menu bar, select Sweep. 

Note: The Sweep option isn't available from 
the following folders: Junk 
Email, Drafts, Sent Items, and Deleted 
Items. 

3. Choose how you want to handle email 
messages from the sender you chose. 

4. Select Sweep to perform the selected 
action.  
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Quick Steps 
Quick Steps in the new Outlook allow you to automate a sequence of actions that you frequently perform, 
such as moving emails to a specific folder, flagging messages, replying with a meeting, etc. They are very 
useful for managing your inbox efficiently, reducing the time spent on repetitive tasks, and helping you stay 
organized. 

For example, if you often move certain emails to a specific folder and forward them to a particular person, 
you can create a quick step to automate these actions in a click. Similarly, if you frequently categorize and 
flag emails for follow-up, quick steps can handle these tasks. 

To create a quick step in the new Outlook app and Outlook online, this is what you need to do: 

1. On the Navigation pane, select Mail. 

2. On the Home tab, click Quick steps. 

If you already have one or more steps in your Outlook, then click the dropdown menu arrow and 
choose Manage quick steps. 

3. In the Settings window, click +New quick step. 

4. Name your quick step. In the first field, enter a descriptive name for your new quick step: 

5. Choose an action. Under Choose an action, select the desired action from the dropdown menu. This 
could be moving an email to a specific folder, pinning, marking complete, categorizing, etc. 

6. Set additional actions. If needed, click Add another action to include more tasks in your sequence. 

7. Add description. In the Optional section, you can add a tooltip description that will appear when you 
hover over the quick step in the ribbon. This helps you remember what each step does. 
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8. Assign shortcut. To create a keyboard shortcut, in the Choose a shortcut box, select the key 
combination you prefer. Available options include Ctrl + Shift + 5 through Ctrl + Shift + 9. 

9. Save your quick step. When done, click Save to finalize your new quick step. 

This way, you can easily create Quick Steps in the new Outlook app and web, saving time on frequent tasks. 
All the quick steps you've created will appear in the dropdown menu on the Outlook ribbon: 

To apply a quick step to a given email, just do this: 

1. Select the message of interest. 

2. In the Outlook ribbon, choose the desired step from the dropdown menu. Alternatively, press the 
keyboard shortcut assigned to the quick step to apply it. 

This will execute all the associated actions in one go. 

Categories 
Categories in Outlook allow you to manage items in many ways. There are three main types of categories 
that we recommend creating: 

• Project (can include people) 
• Topic  
• Location or activity 

Categories aren’t a required aspect of this system, but they will make your life easier if you are diligent 
about using them. For example, they can help you more easily identify what you can do now and help you 
group similar tasks so that you can do them all at once. 

To create categories, do the following: 

▪ In any view, on the Home tab, in the Tags group, select Categorize, and then select All Categories. 

You might be familiar with categories, but they've been significantly 
upgraded. See the category names and colors directly on your messages 
in your inbox.  

To add a Category to the Favorites 

Want to see everything you've tagged with that category? Just click it right 
on your message. You can even add a category to your Favorites. 

1. When an email has a category, click the category icon. 
2. Click the Star icon for Results. 
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Create or Edit an Email Signature 
1. Go to Settings > Accounts > Signatures. 

2. Under Email signature, select New 
Signature. 

Note: Or select the name of the signature 
from the dropdown menu if you want to edit it. 

3. Add and edit any text you want for your 
signature. You can also add images or 
change formatting. 

4. Select Save when you're done. 

Under the email signature editing box, you can 
choose which signature or (No signature) you 
want to show up automatically for New 
messages or Replies/Forwards. 

Send Automatic Out of Office Replies  
Use automatic replies to tell people you won't be responding right away to their email messages. This kind 
of auto-reply "out of office" message is sent only once to each person who sends email to you while you're 
away. 

1. At the top of the page, select Settings > Mail > Automatic replies. 
2. Select the Turn on automatic replies toggle. 
3. Select the Send replies only during a time period check box and then enter a start and end time. 

If you don't set a time, your automatic reply remains on until you turn it off by selecting the Automatic 
replies on toggle.  

1. Select the check box for any of the following options that you're interested in: 

▪ Block my calendar for this period 
▪ Automatically decline new invitations for events that occur during this period 
▪ Decline and cancel my meetings during this period 

2. In the box at the bottom of the window, type a message to send to people during the time you're away. 

If you like, you can use the formatting options at the top of the box to change the font and color of the text or 
customize your message in other ways. 

3. If you want senders outside your organization to get automatic replies, select the check box for Send 
replies outside your organization. 

4. When you're done, select Save at the top of the window. 

If you didn't set a time for automatic replies (step 4 earlier), you'll need to turn them off manually. To turn off 
automatic replies, sign in to Outlook on the web, choose Settings  > Mail > Automatic replies and then 
select the Automatic replies on toggle. 
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Searching 
When searching for something in Mail, you can click at the top in the Search box, type what you are looking 
for. You will be presented with a menu of additional options. 

 

Sent Folder 
The Sent folder has its own unique ribbon options like Recall and Resend. 

 

Undo Send 
You can enable an "Undo Send" option if you're using new outlook to your email address, up 
to a maximum of 10 seconds after selecting the "Send" button. After this option is enabled, 
you can use it to recall a message after it's sent. 
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Calendar 
In the Outlook Calendar, creating a new meeting has had an upgrade. 

 

1. Click to the date and time to add a new event. You will find a simplified popup window. 
2. Click More options to make other changes. 
3. Choose to make the meeting a Teams meeting or an in-person meeting. 
4. Click Save when done. 

In-person Event 
Outlook can help you with scheduling in-person events. Organizers can request invitees to attend the 
meeting in-person, and attendees can respond confirming if they will be able to participate in person or if 
they can only attend virtually.  

Time suggestions for in-person event 
When you mark an event as in-person, the suggested times for the event might change now not only on the 
attendees' time availability, but now also on their location availability. Time slots in which attendees are 
planning to be in the office will be suggested first. 
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Identifying an in-person event 
If you receive a meeting invite that is marked as in-person, you will see visual cues on both the email invite 
and the calendar event to help inform that the meeting organizer has requested attendees to participate in 
person. 

The email invite and the calendar event will both have an [in-person] suffix appended to the title. The mail 
invite will also include an "in-person" label in its contents. 
  

Additionally, the calendar event will also contain a unique 
icon to help identify in-person events. 
  

Responding to an in-person event 
When responding to an in-person request, instead of just 
one "Yes" option, you will now see three. Choose "Yes, in-
person" if you plan to attend the meeting in-person as 
requested by the organizer. Choose "Yes, virtually" if you 
would like to attend, but cannot make it in-person. Or 
select "Yes" - with no attendance mode information - in 
case you prefer to confirm participation, but not disclosing your attendance 
mode. 
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Tracking in-person responses 
As attendees respond to an in-person request, you can track their responses in the tracking pane, 
which displays each person's attendance mode along with their response. 

 

Follow Your Meetings 
Follow is a new meeting response (RSVP) option that goes 
beyond the traditional Accept, Tentative, and Decline 
choices. It is geared towards individuals with high meeting 
loads and conflicting meetings each day. Follow is the ideal 
RSVP option for meetings you can't attend but still want to 
stay engaged and receive information about. Other attendees 
will be able to see if you are following a meeting. 

Outlook Settings 
From the View tab of the ribbon, you can open the settings. On the left side of the window, you will find the 
categories and subcategories in the middle. This is where you will be able to manage your Account(s), set 
up your working days/times and more.  

Open the settings from the top right of the window, click the icon. 
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Using Microsoft 365 Planner and To Do 
Microsoft Planner is a tool for personal task management, team project management, and deadline 
tracking. It uses a visual, project-management approach and integrates with Microsoft Teams. Microsoft To-
do, on the other hand, focuses on personal productivity and offers a simplified list-based structure for 

managing individual tasks. 

Using to-do lists and planners effectively in a finance or accounting department can significantly enhance 
productivity and ensure that critical tasks are completed on time. Here are some best practices: 

1. Prioritize Tasks 
• Categorize Tasks: Divide tasks into categories such as daily, weekly, and monthly. This helps in 

managing recurring tasks efficiently. 
• Use Actionable Verbs: Start tasks with clear, actionable verbs like "review," "reconcile," or "prepare" 

to make them more specific. 

2. Set Clear Deadlines 
• Time Estimates: Assign realistic time estimates to each task to manage your schedule better. 
• Regular Reviews: Review your to-do list daily or weekly to ensure tasks are progressing as planned. 

3. Leverage Technology 
• Sync with Accounting Software: Use tools that integrate with your accounting software to 

automatically update financial data and reduce manual entry. 
• Use Templates: Utilize to-do list templates to streamline your workflow and ensure consistency. 
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4. Maintain Accountability 
• Daily Reconciliation: Reconcile cash and receipts daily to quickly identify discrepancies and 

maintain financial accuracy. 
• Task Justification: Justify each task on your list to ensure it is necessary and aligns with your goals. 

5. Foster Collaboration 
• Shared Planners: Use shared planners for team tasks to improve collaboration and transparency. 
• Regular Meetings: Hold regular meetings to discuss progress and address any issues promptly. 

Implementing these practices can help your finance or accounting department stay organized, reduce 
errors, and improve overall efficiency.  

When to use Microsoft To Do vs. Microsoft Planner 
To Do Planner 

Manage individual tasks across To Do, 
Outlook, and Planner 

Your organization has a Microsoft 365 subscription 
(business, enterprise, or education) 

Make daily to-do lists Manage and schedule teamwork visually 

Share specific lists with teammates and 
friends 

Use charts to track progress 

 
Collaborate across Planner, Teams, and Outlook using 
Microsoft Groups 

 

Microsoft 365 To Do’s 
Microsoft To-Do is an intelligent task management app that makes it easy to plan and 
manage your day. It is a personal task management app that empowers users to track 
and focus on the things they need to get done.  

The primary goal of a to-do list is to outline your priorities, helping you remember 
everything and enabling you to plan your tasks efficiently, so they are completed within 
the necessary time frame. Keeping an up-to-date to-do list provides peace of mind, as it 
clearly shows what needs to be done. 

Microsoft Planner and To Do are powerful tools designed to enhance productivity and streamline task 
management. These tools can help public sector employees organize their workloads, collaborate 
efficiently, and ensure that no task falls through the cracks.  

Public sector organizations are using Planner and To Do to streamline processes, communicate with 
stakeholders, comply with regulations, and achieve outcomes.  



Microsoft Outlook with To Do and Planner 

15 
 

Planner and To-Do can be used to: 

• Plan and execute policy initiatives and programs 
• Coordinate emergency response and disaster recovery efforts 
• Track and report budget and expenditure data 
• Organize training and development activities  
• Collaborate with other agencies and stakeholders 

My Day and Suggestions 
Use My Day to help focus on daily tasks. You can add new tasks directly to My 
Day, or add tasks from other lists, by selecting a task to view its details and then 
selecting Add to My Day. You can also use suggestions to pick tasks to add 
to My Day. To see suggested tasks, select the suggestions icon    at the top of 
the My Day list.  

The My Day smart list resets nightly, giving you a fresh start to add daily tasks. 
Any unfinished tasks are saved to your Tasks list and suggested again the next 
day.  

1. Select My Day.  
2. Select the Today lightbulb icon. 
3. Choose the plus sign to add one of the suggested tasks to your My 

Day list. 

Or, open a list, right-click a task, and select Add to My Day. 

Important Tasks – Use the icon to mark a tasks as Important. You can view all important tasks from 
this category.  

Planned Tasks – Are Tasks that have a due date/reminder. 

Assigned to me – Tasks assigned to you in To Do or Planner 

Tasks – List of all Tasks. 

Add Tasks 
A Task can be added within most areas of the To Do app or within Outlook. 

1. Click on the Add a task icon. 
2. Enter the name of the Task and press enter. 

If you want to add other details to your task, click on the task to open the details pane on the right side. 
Follow the steps below. 
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Add Due Dates and Reminders 
Use due dates and reminders to keep everything on track. Scheduled tasks will 
automatically appear in the Planned smart list, where you can see your tasks 
due today, tomorrow, and beyond.  

Add a due date 
1. Select a task to see its detail view. 
2. Select Add due date and choose when the task will be due: today, 

tomorrow, next week, or a date you pick.  

Add a reminder 
1. Select a task. 
2. Select Remind me and choose when you'll be reminded: later today, 

tomorrow, next week, or a date and time you pick. 

Set a due date to repeat 
1. Select a task. 
2. Select Repeat and choose when your task will repeat daily, on weekdays, weekly, monthly, yearly, 

or a custom repetition. 

Add Steps  
Use steps to break your larger tasks down into smaller, more actionable pieces. 

To add a step: 
1. Click or tap the task to open detail view, select + Add step, and 

begin typing your next step. 
2. When you've finished, select Enter on your keyboard to save and 

close. 

A counter located under each task's name shows the total number of steps 
for the task and how many have been completed up to that point.  
 
Add Importance 

Highlight your important tasks by starring them in each list. Once starred, you can view all prioritized tasks 
in the important smart list. You can also sort each list by importance to have starred tasks appear at the 
top. 

Add Notes 
If you have any extra information you’d like to add to your task, you can Add a note. Select the task to open 
detail view and tap or click within the note to select it. Once selected, you can enter any extra information. 
When you’ve finished, select Save or Done. 

Add Tags 
Keep your tasks organized across different lists by adding hashtags (like #work or #focus) to your tasks' 
names or in the Notes. You can add tags when creating tasks or when editing 
them. 
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You can quickly see all the tasks, notes, and steps that share a tag by 
selecting that tag or searching for it in the search bar. 

You’ll see all the categories you’ve applied to a task in the list view. 

 

To remove a category, select X on the category label, or move your cursor to 

the category selection and delete it. 

Categories for Tasks from Flagged Email  
Tasks generated from emails flagged prior to April 27th, 2020 will not automatically 
reflect the categories of their original emails. To synchronize the tasks with the 
email categories, simply unflag and then reflag the source emails. Note that if you 
apply new categories within To Do, these will replace any existing categories 
associated with the linked emails.  

Sort Tasks 
If you want to change how your Tasks are organized, you can Sort 
them.  

In all the views, look at the top right of the window for the  icon. 
From the menu, you can choose the option that best 
suits your needs. 

Mark a Task as Complete 
When you finish a Task, you should mark it as Complete, so you know it is finished.  

Click the circle icon on the left side of a Task. 

This will cross out the 
task and move it to the 
Completed category.   

Working with Lists and Groups 
Lists are great ways to sort your tasks into common projects or categories. If you have multiple tasks to 
work on that are related, create a List.   

You could have multiple Lists “Grouped” together. 

1. Select New list. 
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2. Type a name for the list. 
3. Press Enter. 
4. Add Tasks to the list. 

Create a Group 

1. Click on Create Group 
2. Click and drag an existing list into the Group. 

Microsoft 365 Planner 
Using a planner in a finance or accounting department offers several benefits that can enhance productivity 
and efficiency. Here are some key advantages: 

1. Improved Organization 
• Centralized Task Management: Planners help keep all tasks, deadlines, and important dates in one 

place, making it easier to manage and track them. 

• Clear Prioritization: You can prioritize tasks based on urgency and importance, ensuring that critical 
tasks are completed first. 

2. Enhanced Collaboration 
• Shared Access: Team members can access and update the planner, promoting transparency and 

collaboration. 

• Real-Time Updates: Changes and updates are visible to everyone in real-time, reducing 
miscommunication and ensuring everyone is on the same page. 

3. Better Time Management 
• Scheduled Reminders: Planners can send reminders for upcoming deadlines and meetings, helping 

to avoid last-minute rushes. 

• Time Blocking: Allocate specific time slots for different tasks, which can improve focus and 
productivity. 

4. Increased Accountability 
• Task Assignment: Assign tasks to specific team members, making it clear who is responsible for 

what. 

• Progress Tracking: Monitor the progress of tasks and projects, ensuring that everything is on track 
and identifying any potential delays early. 

5. Streamlined Workflow 
• Recurring Tasks: Set up recurring tasks for regular activities like monthly reconciliations or quarterly 

reports, reducing the need to manually enter them each time. 

• Integration with Other Tools: Many planners can integrate with other tools and software, such as 
accounting systems, to streamline workflows and reduce manual data entry. 
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6. Enhanced Reporting and Analysis 
• Data Insights: Use the planner to track task completion rates, identify bottlenecks, and analyze team 

performance. 

• Historical Data: Maintain a record of past tasks and projects, which can be useful for future planning 
and audits. 

Implementing a planner can lead to a more organized, efficient, and collaborative finance or accounting 
department.  

Microsoft Planner in Teams combines the ease of To Do, the collaborative tools of Planner, and 
the capabilities of Project for the web into one seamless experience.  

Microsoft Planner in Teams has unveiled several new features to boost productivity and 
collaboration: 

• Unified Experience: The new Planner combines the simplicity of Microsoft To Do, the collaboration 
features of Planner, and the power of Project for the web into a single, unified experience. 

• Streamlined Navigation: The interface now includes three main sections: My Day, My Tasks, and My 
Plans, making it easier to navigate and manage tasks. 

• Enhanced Views: New views such as Timeline (Gantt) view with dependencies, Goals view, and 
People view have been added to help you better visualize and manage your projects. 

• Premium Plans: Users with an M365 license can access premium features like Sprint planning, 
custom fields, and more. 

• Copilot Integration: The new Planner includes Copilot, which can help break down tasks into 
subtasks, identify work needed to meet project goals, and answer questions about project status. 

• New Icon: A new Planner icon has been introduced, representing the expanded capabilities and 
vision of the app. 

Use Planner within a Team Channel 

1. Navigate to a Team Channel and Add a Tab by clicking the plus sign. 
2. Click the Planner app. 
3. Create a new plan or connect to an existing plan. 

My Day 
My Day is a clutter-free focus space that helps you stay on top of tasks that you want to focus on today. 
Tasks from My Tasks and personal plans that are due today will show up in My Day. You can also create 
tasks that you feel are important and may need your attention. 
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Your daily dashboard: 

• Handpicked priorities: Determine and add your main tasks for the day. 
• Auto-population: Tasks from My Tasks and personal plans that are due today automatically appear 

on My Day, keeping you on top of important deadlines. 
• Prioritize and work on these tasks: Once the tasks are on My Day, you can prioritize the tasks in the 

order you want to accomplish them today. 
• Start fresh in My Day each day: My Day clears itself every night, so you can start the next day with a 

blank slate and personalize your day. Any unfinished tasks in My Day that are left over before it clears 
will be available in the original Plan that they came from. 

My Tasks  

My Tasks: This view includes: 

• Private tasks: Private tasks are a place for you to quickly jot down tasks at the speed of thought. This 
is a place where you can create tasks that do not belong to a plan yet. You can then further organize 
these tasks inside Plans by selecting More actions, which will help you move these unorganized tasks 
in definitive plans. 

• Assigned to me: Includes all the tasks that have been assigned to you in Teams meeting notes, basic 
plans, premium plans, Loop component, and shared lists in To Do. 

• Flagged emails: All your flagged emails from Outlook appear in the Flagged emails section. You can 
also navigate to the emails directly from the task by selecting the attachment. 

• All: The All view provides an aggregation of all your individual tasks from Private tasks, Assigned to 
me, and Flagged emails. You can then filter and sort to meet your needs. For example, if you want to 
see all your tasks that are due tomorrow and are urgent, just apply the filter on this view and you will 
get a curated list of tasks. 

My Plans 
My Plans shows all the user's To Do lists, basic plans, and premium plans. 

You can create a new personal or shared plan by clicking the icon at the top right.  

The My Plans page in Planner shows all your plans, no matter where they were created. This includes lists 
created in To Do, plans created in Planner and Project for the web, Loop plans, plans from Teams meeting 
notes, and more. 

The My Plans page provides five filters to help find the right plan or list: 
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▪ Recent: Shows your most recently accessed plans and 
lists. 

▪ Shared: Shows your shared plans and lists. 
▪ Personal: Shows your personal plans and lists. 
▪ Pinned: Shows all plans and lists you have pinned. 
▪ My teams: Shows all your plans that are shared with a Team’s channel. 

Planner View in Teams 
Microsoft Planner offers several views to help you 
manage and visualize your tasks effectively: 

• Board View: This is the default view where tasks are organized into columns or “buckets.” You can 
easily move tasks between buckets by dragging and dropping.  

• Charts View: Provides a visual overview of your plan’s progress, showing the status of tasks, the 
number of tasks assigned to each team member, and more. 

• Schedule View: Displays tasks on a calendar, allowing you to see upcoming tasks and deadlines. You 
can drag and drop tasks to set dates. 

• Grid View: Offers a detailed, data-centric view of your tasks, like a spreadsheet. 
• Timeline (Gantt) View: Shows tasks in a timeline format, highlighting dependencies and helping you 

track project progress. 

These views can help you and your team stay organized and ensure that tasks are completed on time.  

Planner Templates 
Microsoft Planner provides pre-made templates to give you a quick start on new plans, supporting various 

types.  
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1. Once you click on a template, you will see a more complete view, note the specific template's 
sections and key benefits.  

2. Select Back to view other templates -- or proceed as follows: 
3. Add a title for your new plan. 
4. Optionally, use the drop-down list to Add to an existing group.  
5. Open and respond to Privacy and Sensitivity options.   
6. Select the Create button to proceed into the new plan.  

Managing Tasks 

Add Tasks  
Once you have a Plan created, whether it was a blank or template, you will want to start adding in new task 
or updating ones that already exist. 

1. Click The new task panel will open. Enter a name for the task, a due 
date, and who it’s assigned to. Click the Add Task button to create the task. 

2. Once a Task has been added, you can click on it to open the Task dialog box. 
There are options to add a status, a priority, a due date, notes, checklists, 
attachments, and more. You can assign labels to color-code your tasks to the 
right of the item.  

3. Close the Task window when finished (there is no Save button). 

Notifications 
Once you are assigned a Task, you will receive an email notification with a link to the Task. Once the date of 
when the Task is due approaches, you will receive an email notification. 

Task notifications will appear in your Teams activity feed both on your desktop and in the Teams mobile 
app. You'll get a notification when: 

• Someone else assigns a task to you. 
• Someone else assigns an urgent task to you. 
• Someone else makes a task assigned to you urgent. 
• Someone else makes a task assigned to you not urgent. 
• Someone else changes the progress of a task assigned to you. 
• Someone removes you from a task's assignees. 

Add Task Details 
1. Select the task. 
2. Select the Progress drop-down to change the progress: Not started, In progress, or Completed. 
3. Type a Description. 
4. Under Checklist, select Add an item and type the item you want to add to the checklist. 
5. Select Add attachment and choose the type of attachment. 

You can upload a File, provide a Link (URL), or attach a file in the SharePoint site associated with your 
plan's group. 
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6. Type a comment and select Send. 
7. Comments go to the group's inbox, and you can also choose to receive these directly in your email 

inbox. 
8. Select the Show on card checkbox to show your description, checklist, or attachment on the task 

card. 
9. To quickly add similar tasks to your plan, select the three dots ... and then Copy task. 

• Type a new name. 
• Under Include, select the checkboxes for which items you want to include in the new task. 
• Select Copy. 

Use Buckets 
While a long list of tasks works, having multiple lists is more effective. Planner uses Buckets to organize 
tasks, starting with one Bucket named To Do. You can name buckets and add new or existing tasks by 
dragging them or clicking New Task under the bucket name. Utilizing Microsoft Planner buckets boosts 
productivity and organization. Here are the main benefits: 

• Task Organization: Buckets allow you to group tasks by categories such as project phases, 
departments, or priority levels. This helps in breaking down complex projects into manageable parts. 

• Visual Clarity: By sorting tasks into buckets, you get a clear visual representation of your workflow. 
This makes it easier to track progress and identify bottlenecks. 

• Flexibility: You can move tasks between buckets as their status changes, providing a dynamic way to 
manage your tasks. For example, you can have buckets like “To Do,” “In Progress,” and "Completed". 

• Collaboration: Buckets make it easier for team members to see what needs to be done and who is 
responsible for each task. This fosters better communication and collaboration. 

• Customization: You can customize buckets to fit your specific needs, whether it’s for different types 
of work, project stages, or even brainstorming ideas. 

To Add a Bucket 

1. Select Add new bucket. 
2. Type a name that makes sense for your project: phases, types of work, and so on. 
3. To add an emoji, press the Windows key plus the semicolon, and pick an emoji. 

Organize Tasks 
You can Filter or use Group By to organize the tasks in your list. By default, they are Grouped By Bucket, but 
you can change this at any time. 

Assign People to Tasks 
When you're ready to decide who's doing what, there are several ways you can 
assign tasks to people in Planner. 

When creating a task, you have the option to assign it to someone. Start by adding 
a task name, then click on Assign to pick a team member from the list. If the 
person you need isn't shown, you can type in their name or email address in the 
search box to include a new individual. 
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A task can be assigned to multiple people. If more than one team member is working on a task, you can 
assign it to up to 11 individuals, so they all see it in their Assigned to me list. Once any team member 
completes the task, it is marked complete for everyone. 

Change Assignments 
You can also change the Board to be grouped by Assigned to, and then drag 
tasks between the columns for each person on your team. 

Need to Remove Someone? 
If you no longer need someone on your plan, select the arrow next to the plan 
members, point to the person you're removing, select the three dots, and 
then choose Remove. 

 

Outlook Tasks Integration 

Outlook Online 
In Outlook for the web, Microsoft To Do is easily accessible for you to track your tasks, share tasks, and 
keep yourself focused on what's important to you. 

From Outlook Online, click on the To Do icon from the menu.  

Outlook Desktop 
Outlook Desktop also works with To Do’s within Tasks.  

Open Outlook Tasks and click on To-Do List, if necessary. 

NOTE: viewing a Task from Outlook Tasks, will not show Steps.  

 

  



Microsoft Outlook with To Do and Planner 

25 
 

Working with Planner/To Do’s in Outlook 
Microsoft To Do is now integrated with Outlook.com. To Do is taking the place of Tasks and includes smart 
lists. Smart lists are filtered lists that make it easier to track tasks and organize your day. With To Do 
integration, you can quickly organize your tasks by adding them to My Day, marking them as important, or 
adding them to new lists that you create. There's even a list for tasks that you've assigned a date to. 

See your Planner Schedule in Outlook Calendar 
Plan your time better by seeing your Planner tasks on your Outlook calendar. 

1. At the top of your Planner board, select the three dots ... 
2. Select Add plan to Outlook calendar. 

Notes:  

1. If you don't see this option, the plan owner needs to publish the plan as an Outlook calendar: 
2. The plan is now public for all members of the plan. 

Select the three dots ...  
Select Add plan to Outlook calendar. 
Select Publish, and then select Add to Outlook.  

3. On the Subscribe from web tab, change the Calendar name if you like, and select Import. 

View your plan and tasks in Outlook 
1. Under Other calendars, select your plan. 
2. Select a Planner task to see a quick view. 
3. To see more details, select the View event arrow in the upper right. 

Here you can see dates, progress, and a checklist summary. 

You can also select Open this task in Microsoft Planner. 

In Planner, you're able to edit this task as usual. 
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Microsoft Project Integration with Planner 
Microsoft Project Online is a stand-alone app but can also be used with Microsoft Planner and To Do’s. 

A key challenge in team projects is estimating completion time, meeting deadlines, and prioritizing tasks, 
especially with many interdependencies. Effective work management 
tools are essential for boosting momentum and efficiency. Microsoft 
Planner addresses these issues with advanced features like 
Dependencies and Critical Path Identification in the Timeline view, 
making project management more accurate and efficient.  

Creating a Premium Plan 
You can use Microsoft Planner for project management. Here are 
some key features and steps: 

1. Advanced Task Dependencies: 
o Microsoft Planner allows you to define complex task relationships, crucial for managing 

interconnected tasks efficiently. 
o Supported dependencies include:  

▪ Finish-to-Start (FS): Task 3 starts after Task 2 finishes (default dependency). 
▪ Finish-to-Finish (FF): Task 3 finishes when Task 2 finishes. 
▪ Start-to-Start (SS): Task 3 starts when Task 2 starts. 
▪ Start-to-Finish (SF): Task 3 finishes when Task 2 starts. 

o You can also add lead and lag times between tasks. 
o Set up dependencies by linking tasks and specifying the type of dependency. 

2. Viewing Critical Path on Timeline: 
o The critical path is the longest sequence of tasks that determines the project’s finish date. 
o Microsoft Planner’s scheduling engine automatically calculates this for you. 
o Easily identify and prioritize tasks that impact your project’s timeline. 

To enable premium features in Microsoft Planner, you can start a 30-day free trial or request a premium 
license. Here’s how you can do it: 

Starting a 30-Day Free Trial 

1. In Teams: 
o Open the Planner app within Microsoft Teams. 
o Click on the diamond icon in the upper right-hand corner. 
o Select “Try Project” to begin your free 30-day trial of premium features. 

2. On the Planner Website: 
o Visit the Planner website. 
o Click on the “Try Project” button or select the “Timeline” menu option. 
o Follow the prompts to start your trial. Depending on your organization’s settings, you may 

need to request approval from your administrator. 
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Requesting a Premium License 
If you want to continue using premium features after the trial, you can request a premium license from your 
administrator. This will give you access to advanced capabilities such as: 

• Timeline (Gantt) View 
• Dependencies 
• Custom Fields 
• Sprints 
• Team Workload Management 
• Goals View 
• Copilot Integration 

These features can significantly enhance your project management experience by providing more detailed 
insights and better task management tools. 

Using premium features in Microsoft Planner can significantly enhance your project management 
experience. Here are some best practices to get the most out of these features: 

1. Utilize the Timeline (Gantt) View: 
o Plan Dependencies: Use the Timeline view to map out task dependencies. This helps in 

visualizing the sequence of tasks and ensuring that critical tasks are completed on time. 
o Adjust Timelines: Regularly update and adjust timelines based on project progress to keep 

everyone aligned. 
2. Leverage Custom Fields: 

o Tailor Task Details: Add custom fields to tasks to capture specific information relevant to 
your project. This can include priority levels, risk assessments, or any other custom data. 

o Filter and Sort: Use these custom fields to filter and sort tasks, making it easier to focus on 
high-priority items. 

3. Sprint Planning: 
o Define Sprints: Break down your project into manageable sprints. This helps in setting short-

term goals and maintaining momentum. 
o Track Progress: Use the Sprint view to monitor progress and adjust workloads as needed. 

4. Goals View: 
o Set Clear Objectives: Use the Goals view to define and track project objectives. This ensures 

that all team members are aligned with the project’s overall goals1. 
o Monitor Achievements: Regularly review and update goals to reflect the current project 

status and celebrate milestones. 
5. Team Workload Management: 

o Balance Workloads: Use the People view to see the distribution of tasks among team 
members. This helps in balancing workloads and preventing burnout. 

o Reallocate Tasks: Quickly reassign tasks if some team members are overloaded or if 
priorities change. 

6. Copilot Integration: 
o Break Down Tasks: Use Copilot to break down complex tasks into smaller, manageable 

subtasks. 
o Get Insights: Ask Copilot for insights on project status and recommendations for improving 

efficiency. 

https://techcommunity.microsoft.com/t5/planner-blog/the-new-microsoft-planner-begins-roll-out-to-general/ba-p/4101056
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Advanced Task Dependencies 
Microsoft Planner allows you to define complex task relationships, crucial for managing interconnected 
tasks efficiently. Here's an overview of the dependencies that are supported:  

• Finish-to-Start (FS): Task 3 starts after Task 2 finishes (default dependency). 
• Finish-to-Finish (FF): Task 3 finishes when Task 2 finishes. 
• Start-to-Start (SS): Task 3 starts when Task 2 starts.  
• Start-to-Finish (SF): Task 3 finishes when Task 2 starts. 

Steps to Set Up Dependencies: 

1. Create Tasks: Begin by listing all tasks within your plan. 
2. Link Tasks: On 

a task row, under 
the 'Depends on' or 
'Dependents 
(after)' column, click 
on the cell to choose 
the task the current 
task is dependent on 
followed by type of 
dependency (FS, SS, 
FF, SF). 

3. Add Lead and Lag 
Times: You can also 
add lead and lag 
times through the 
same menu in days, hours, minutes, weeks or months. 

Viewing Critical Path on Timeline 
Understanding the critical path is essential for timely project completion. The critical path is the longest 
sequence of tasks that determines the project's finish date. Microsoft Planner’s scheduling engine 
automatically calculates this for you, ensuring you can easily identify and prioritize the tasks that will 
impact your project's timeline. 

Example: Imagine you are organizing a conference: 

1. Book Venue: 3/5 - 3/10 
2. Write Invitation list: 3/5 - 3/15 
3. Send Invitation: 3/10 - 3/20 

If tasks have no dependencies, the critical path is the "Send invitation" task, as it ends at the latest and thus 
defines when the project will end. If there was a dependency "Write Invitation list" → "Send invitation," the 
critical path would be "Write Invitation list" and "Send Invitation," as their sequence defines the project's 
end date.  
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Steps to View Critical Path in Microsoft Planner: 
1. Navigate to the Timeline view. 
2. Toggle on the critical path filter to highlight critical tasks in red. 

 

 

 


